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1. INTRODUCTION 

This course is presented as part of the Smiths Aerospace Productivity 

Improvement Initiative to help Smiths Aerospace Electronic Systems–

Grand Rapids Engineers develop Word 97 documents quicker, cheaper, 

and better, and to reduce cost, time, rework, and frustration in the 

document preparation process.  

 

This is not strictly a Microsoft® Word proficiency course.  Instead, it is 

meant to be a practical application of Word to the internal document 

process at Smiths to prevent duplication of effort between Engineer and 

Document Writer. 

 

Use charge number 110 for this class. 
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2. DOCUMENT PROCESS 

2.1 Introduction to Technical Publications. 

Department E520 contains two functional groups:  Technical Publications, 

comprising the Publications Writers, and Technical Writing Support (TWS), 

comprising the Document Writers.  

a. Pubs Writers – develop Technical Orders (TOs), Technical Manuals 

(TMs), Illustrated Parts Lists (IPLs), Illustrated Parts Breakdowns 

(IPBs); also provide I-Level, O-Level, and Depot-Level training to 

Customers. 

b. Doc Writers (TWS) – develop product development documents, such 

as Software Development Plans, System and Software Requirements 

Specs, Software Design Specs, Test Plans, Test Procedures, Test 

Reports, User’s Manuals, Reference Manuals, etc.  We are the 

writers that you would work with to develop your engineering 

documentation.  The current Grand Rapids Doc Writers are: 

• Rod Blom – x7709 

• Micki Borrink – x8855 

• Carol Conant – x7411 

• Skip Coryell – x8263 

• Connie Ferris – x8341 

• Bob Fry – x8294 
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• Matt Lawless – x7855 

• Linda Lawrence – x8368 

• David Ziegler – x8139 

2.2 Process flow (for deliverable Engineering documents). 

• Contact Doc Writer (responsibility of Engineer) 

• Request doc number from CMO (Doc Writer)  

• Determine correct Data Item Description or template (DW) 

• If elec. version exists, revise to new document (Eng.); otherwise, 

• Generate new document (Eng.) 

• Submit to Doc Writer (Eng.) 

• Provide charge number to Doc Writer to do the work (Eng.) 

• Edit/format document (DW) 

• Return to Engineer for review, incorporate Engineer comments 
(DW) (optional) 

• Submit to signature cycle (DW) – DW, Author, Lead Eng., Project 
Manager, Integrated Logistics Support (ILS), Quality Assurance 
(QA), Configuration Management (CM), Data Quality (DQ) are 
some of the usual signatories; determined by IP415 

• Incorporate review comments (DW) 

• Submit to Data Quality, incorporate DQ comments (DW) 

• Submit to Data Manager or Contracts (DW) 

• Submit to Customer (Data Manager (DM) or Contracts) 

• Receive/incorporate Customer comments (DM, Eng., DW) 
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• Re-submit to Customer (DM or Contracts) 

• Receive Customer approval (DM or Contracts) 

• Release document (DQ, CMO) 

• Receive Customer request for changes (EPM or Eng.) 

• Submit Change Order (CO) to Change Management Organization 
(CMO) to update document to new revision (Eng. or DW) 

• Update document (CMO) 

• Approve document by email through virtual Change Control Board, 
or CCB, process (Eng., QA, CMO) 

• Submit new revision to DM or Contracts (CM) 

• Submit new revision to Customer (DM or Contracts) 

• Receive/incorporate Customer comments (DM, Eng., DW, CMO) 

• Re-submit to Customer (DM or Contracts) 

• Receive Customer approval (acceptance in UK)(DM or Contracts) 

• Release new revision (CMO) 

 

Note!  When schedule is important, timeliness is everything.  Don’t submit 

your data item to the Doc Writer at the last minute, 3 days before it is due 

to the Customer.  A document’s typical development cycle from Doc Writer 

receipt to submittal to Customer is 4 weeks, and Doc Writers build this into 

a document’s milestone schedule.  The 4 weeks includes the review and 

signature cycles.  When everything is hot, quality suffers:  documents 

are flagged for correction by signatories and rejected by the Customer. 
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2.3 Document Preparation Manual (DPM) – TDM1981. 

The Document Preparation Manual is the Grand Rapids in-house 

standard for the document process and document formatting.  It is the 

guide that the Doc Writers follow for all documents not contractually 

formatted in accordance with a Contract Data Requirements List (CDRL) or 

Data Item Description (DID).  If the program contract (via a CDRL or DID) 

governs the content and format of a document, it takes precedence over 

the DPM.  Section 3 of the DPM gives a detailed description of the 

document-development processes, and Appendix II provides the minimum 

standards for formatting.  For an electronic version of the DPM, go to: 

 

Smiths Aerospace ES–Grand Rapids Intranet Home Page à  

Documentation àà  es document preparation manuals àà  manual 

 

2.4 Deliverable vs. non-deliverable documents. 

a. Deliverable document goes to Customer for approval; rejection by 

Customer requires Smiths Aerospace to incorporate Customer-

requested changes.  It may have certain content and structure 

requirements defined by contract, or contract may call out a Data 

Item Description.  If Customer specifies Supplier format, document 

follows DPM. 

b. Non-deliverable document is internal only – no Customer approval 

rights.  Follows DPM. 
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2.5 Developmental, Pre-Production, and Production release. 

a. Developmental release – This is the easiest and least expensive 

type of release to obtain. It is not required to follow the format 

described in the DPM, and requires only two signatures for release:  

Doc Writer and Function Engineer. While this release is under CMO 

control and stored in the CMO vault, it is not microfilmed.  The 

baseline is Revision X1 and subsequent revisions are X2, X3, etc.  

This release can be upgraded to Production release at any time by 

obtaining the required approval signatures of IP415 and making the 

document conform to the format of the DPM. 

Note of Caution: While economical and quick to achieve, you should 

think it through before choosing this release. A Developmental 

release should not be used to ship a document in its Final form to the 

Customer for approval, only for his review and comment. (This would 

violate the Data Warranty Compliance clause, which is standard in 

most contracts.)  

b. Pre-Production release – This type of release is similar to what 

used to be called a redline release at Smiths Aerospace. The 

signature requirements are more stringent and are defined in IP415. 

A Pre-Production release must also follow DPM formatting 

requirements. This release is more costly than Developmental and 

takes about an extra 2 weeks to get through the release cycle. 

However, this type of release is superior to Developmental in that it 

can be used to support the building of prototypes. This release is 

stored in the CMO vault and is sent out for microfilming. It can be 
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upgraded to a Production release by going through the Change 

Control Board (CCB).  The baseline is Revision 1 and subsequent 

revisions are 2, 3, etc.  Changes to a released baseline are 

accomplished using a formal Change Order (CO).  There is little or no 

advantage to releasing a document as Pre-Production instead of 

Production. 

c. Production release – This type of release is similar to what used to 

be called a blueline release. It is our highest level of control and our 

best effort as a company.  It is the most costly and time-consuming to 

obtain. However, it is the only release that will support a full-

production effort, and the only release that can be submitted to the 

Customer for final approval. The signature requirements are the most 

stringent and are defined in IP415. A Production release must follow 

DPM formatting requirements.  The baseline is Revision “—“ and 

subsequent revisions are A, B, C, etc.  Changes to a released 

baseline are accomplished using a formal Change Order (CO). 

2.6 Document signature routing process. 

When a document is completed, it is sent for review, electronically or hard 

copy, to all required signatories as determined by IP415.  A Document 

Approval Route Sheet with the names of the signatories accompanies it, 

and as each one completes the review, he or she signs the route sheet.  

After signing, please deliver the document and sheet to the next person on 

the list; do not return them to the Doc Writer.  See Figure 1 for a sample 

route sheet. 
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DOCUMENT APPROVAL ROUTE SHEET 

 

DOCUMENT NO.:  SUBMITTAL STAGE: DRAFT PRELIM FINAL 
      
TITLE:  

THE FOLLOWING INDIVIDUALS’ (OR DESIGNEES’) REVIEW AND APPROVAL 

ARE REQUIRED PRIOR TO RELEASE OR SUBMITTAL TO THE CUSTOMER FOR 

APPROVAL. 

DEPARTMENT  NAME  SIGNATURE  DATE 

Preparer/TWS       

Fctn. Eng       

Dept. Manager       

ILS       

SQA       

CM       

DQ       

ORIGINATOR:  COMPLETE INFORMATION AT TOP OF PAGE AND OBTAIN SIGNATURES OF THOSE NECESSARY 

DEPARTMENTS (AND COGNIZANT INDIVIDUALS) REQUIRED FOR DOCUMENT RELEASE IAW IP4059.  UPON 

RESOLUTION OF ALL COMMENTS, STORE THIS APPROVAL SHEET IN THE ENGINEERING TRACING FILE. 

 

REMARKS:  

 
 
 
 

SIGNED:  EXT:  DATE:  
 
 
 

Figure 1.  Document Approval Route Sheet 
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2.7 Document review checklist. 

The Doc Writer always completes a checklist before submitting a document 

for signature, to ensure that all TWS requirements have been met and 

TWS tasks completed.  Table 1 shows a sample document review 

checklist.  This checklist accompanies the document and route sheet. 

2.8 Quality Assurance (QA), Configuration Management (CM), and 

Data Quality (DQ). 

QA, CM, and DQ all play a part in the document-development and  –review 

process, and are standard signatories to most documents. 

a. Quality Assurance – QA at Smiths Aerospace monitors all phases of 

software development to ensure that required processes are 

conducted and that the products of development activities 

demonstrate compliance with contract requirements. QA is involved 

in required document reviews and approvals to ensure that all 

engineering groups fulfill their responsibilities. To accomplish this, QA 

undertakes the following activities: 

• Monitors and audits review processes. 

• Audits, as necessary, document revisions against open 
issues/comments posted at reviews. 

• Contributes to the resolution of documentation questions raised by 
team members. 

• Conducts independent reviews to establish that developers have 
indeed reached completion. 

• Grants signature approval to all fully compliant software documents. 
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Table 1.  Document Review Checklist 
DOC. NO.: YV1836  TYPE OF MEDIA: Word 97 
DOC. TITLE Cutting Document Costs  DATE RCVD FROM ENGINEERING: 5/1/02 
AUTHOR: R. Blom  DATE READY FOR WALKTHRU: 5/8/02 
VSS LIB:   DATE WALKTHRU SCHEDULED: 5/13/02 
EPA NO.: E927020306  PROJECT: PII 
DIRECTORY: D:\My Docs\MS Word for Engineers  DUE DATE: 5/15/02 
PROJ ENGR: A. J. Hackney  DOCUMENT DATE: 15 May 2002 
TECH PUBS: R. Blom    

 
TASK: COMPLETE: NOTES: 
Pre-review Checklist:   X  
-----Check deadline X  
-----Check format X Supplier format (DPM) 
-----Verify document number & title correct X  
-----Verify DELIVERABLE or non-deliverable X  
-----Verify draft, preliminary, or FINAL X  
-----Verify type of release X PRODUCTION RELEASE 
-----Check CDRL requirements (no distribution statement) X  
TWS General Content Review: X  
-----Verify document meets DID/OI structure requirements X  
-----Verify document meets DID/OI wording requirements X  
-----Resolve TBDs with project engineer X  
-----Edit for conciseness & clarity X  
-----Write any needed text X  
-----Verify figures complete NA No figures in doc 
-----Verify company name correct X  
Section 1:   X  
-----Verify model, CN  numbers are correct X  
Section 2:   X  
-----Verify APP DOCS paragraph format correct X  
-----Check wording in paragraphs 2.1, 2.2 & 2.3 X  
-----Verify referenced documents listed in Applicable Documents X  
-----Verify unreferenced documents deleted from APP DOCS X  
-----Verify hardware listed under DRAWINGS X  
-----Verify 2.3 is present if document references software NA No software referenced 
-----Verify Applicable Documents listed in alphanumeric order X  
-----Verity referenced document titles correct X  
TWS General Format Review: X  
-----Verify Figures & Tables follow first reference X  
-----Verify Figures pasted (manual/electronic) NA No figures in doc 
-----Verify acronyms follow MIL-STD & conventions X  
-----Verify acronym list accurate and complete  X  
-----Determine if Revision History sheet required (set counter) X  
-----Run Spell X  
Media Control: X  
-----File figures (database/document) X  
-----Complete VSS/CMS control for text files X  
-----Provide .PDF file to Data Quality  When released 
Make Final Check for Total Presentation: X  
-----All pages in document X  
-----Document smudge free/clean print X  
Make Routing Sheet (if required) X  
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b. Configuration Management – CM identifies all configuration items  

and their control levels (e.g., CM determines whether a specification 

must be CO-controlled).  CM monitors documentation release status; 

change orders/proposals; change notices; and configuration review 

boards, audits, reviews, deviations, and waivers.  CM reviews 

documents to demonstrate that they are in compliance with 

contractual requirements.  See Table 2 for a CM checklist. 

c. Data Quality – DQ ensures that all data prepared at Smiths 

Aerospace meets the minimum level of quality. DQ accomplishes this 

task by performing audits and by reviewing documentation as 

necessary.  See Table 3 for a DQ checklist. 

Table 2.  Configuration Management Checklist 

Task Complete Notes 

o Does the document correctly identify the following:   

• CI Number  

• Government Nomenclature    

• Smiths Nomenclature   

• Part or Drawing Number  

• Approved Smiths or Government Acronym 

• CPIN   

o Are the Smiths documents and Smiths 
drawings/PNs referenced 
correctly and relevantly for the document? 

o Are the referenced drawings/documents under  
the proper release status?    
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Table 3.  Data Quality Checklist 

Document No.______________________________________________________ Revision__________ 

Title _______________________________________________________________________________ 

Task Notes 
o Have required signatures been obtained IAWIP415?, 

using the Document Approval Routing Sheet? 
 

o Does the data cover sheet comply with these: CDRL, DID, IP, OI and/or 
DPM? 
o Is the document format compliant with these: CDRL, DID, IP, OI and/or 

DPM? 
o If the document was prepared to a tailored DID, does document comply with 

the approved tailoring? 
o If the DID, IP, OI, and/or DPM requires mandatory wording or statements, 

(e.g., Distribution Statement) is it accurate and correctly placed? 
o Have all the sections of the DID, IP, OI, and/or DPM been 

included in the document, as required? 
o Do the preface pages comply with these: CDRL, DID, IP, OI, and/or DPM for 

numbering? Titles? Format? 
o Are paragraphs called out by CDRL, DID, IP, OI, and/or DPM properly titled? 

 

o Are paragraphs/topics properly numbered? 
o Are subparagraphs in correct font style per the standard? 

 

o Are the tables and figures accurately labeled? 
o Are figures and diagrams clear, not busy.  Do they avoid 

intersecting lines with text or labels? 
o Are ‘‘paste-ups’’ parallel to borders and of matching fonts? 
o Do the table of contents, list of figures, list of tables, and 

list of appendices (if applicable) match the actual reference? 
o Are the figures/tables properly referenced in preceding text? 

 

o When referencing within the text, are references identified properly as 
document numbers, not as titles, etc.? 

 

o If appendices are included, are they located properly? Correctly numbered? 
Properly referenced in text? Free of errors, such as spelling? Consistent and 
relevant? 

 

o Are the CM and Document Preparation checklists completed and attached?  
o Does the document reflect all Customer comments? 
o If Customer comments are not to be incorporated, is a letter of 
rebuttal/explanation included? 
o If comments in addition to Customer comments were incorporated, have they 
been identified for inclusion in the letter of transmittal? 

 

o If the document is a revision, has it been properly identified as such? 
o If change pages are involved, do they include alphanumeric identification?  
o If change bars are used, do they properly identify only the changed text, and 
are they properly located? 

 

o Is the document laid out appropriately for binding? 
o Will printing meet reproducibility requirements? 
o Is there unnecessary or excessive ”white space” in the document? 
o Are the pages properly numbered and sequential? Are they complete? 
o Are pasteups secure in the master document so they will not be lost or 
become detached? 
o Are the .PDF and native files properly stored in CMO? 

 

Reviewer_________________________________________Date______________________ 
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2.9 Product Data Manager tool (PDM). 

PDM is the online database managed by Configuration Management that 

tracks and stores all releasable documents (and drawings and software) 

produced by Smiths Aerospace Grand Rapids and Clearwater sites.  For 

those with full PDM access (Doc Writers), it shows full document titles, 

signoff status, release status, etc.  Call a Doc Writer if you need that 

information.  Otherwise, if a document has been released, the PDM Lookup 

page on the Intranet shows a PDF version of the document itself.  

Intranet Home Page à click PDM on the bottom of the page 

Note:  PDM will probably be replaced by a data management system 

called eDMS sometime in the future. 

2.10 Visual SourceSafe (VSS). 

VSS is an electronic library/database for storing and tracking versions of 

the masters of documents, drawings, software, and procedures.  Each 

project has its own VSS library.  The Doc Writers use it to store current 

versions of the documents they are working on.  

 

To be sure you are working on the latest version of a document, use the 

VSS version.  If you don’t have VSS or don’t have access rights to a project 

library, ask the Doc Writer to check out the VSS version for you.  If the doc 

is currently checked out, its owner will first need to check it back in. If you 

need VSS training, contact any Doc Writer.  If you need VSS loaded or 

access rights to a library, call the Help Desk.  They will need the project 

EPM’s authorization to process your request. 
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Note:  VSS will be replaced with a document management system called 

Dimensions in the near future. 

2.11 Security/export control. 

a. Remember, there are specific requirements for the labeling of 

proprietary data, and marking of defense controlled technical data.  If 

you have any questions along these lines, contact the Security Office 

or your Doc Writer. 

b. The Doc Writer is responsible for working with the project to ensure 

that any required Export Notice, Proprietary Statement, Copyright, 

and/or any security markings are placed on the document. 
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3. TEMPLATES 

Always use an existing Word template when creating a document from 

scratch; it does much of the formatting for you and contains all the Word 

styles you’ll need for most documents.  Don’t reinvent the wheel.  

Templates provide cost and time savings. 

3.1 How templates save time. 

a. They already contain required formatting. 

b. They already contain the required paragraphs. 

c. They already contain the required styles. 

Caution:  If you clone a document from a legacy document, the legacy 

document might be written in accordance with an old template. 

3.2 Template location. 

Always go to the Intranet for the latest template, because they are 

updated as requirements and company nomenclature change. 

a. Intranet Home Page à Documentation  àà  es document 

preparation manuals àà  templates. 

b. Or, at address:  http://ims-gr.si.com/dpm/dpm-web%20info. 
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3.3 Template types. 

a. Dpm-style-doc.dot – most often-used template – see Appendix I 

• CM (Configuration Management documents) 

• ED (Plans) 

• HDP (Hardware Development Plan) 

• HDS (Hardware Design Specification) 

• HRS (Hardware Requirements Specification) 

• àLA (Non-U.S. Military System Spec, e.g., ICD) 

• LB (Non-U.S. Military Development Spec, e.g., SRS) 

• LC (Non-U.S. Military Product Spec, e.g., SDS) 

• LE (Logistics Support document) 

• NS (Nuclear Survivability document) 

• PD (Test Procedure) 

• PF (Detail Design Spec) 

• PH (Test Plan/Procedure) 

• PJ (Field Operating Procedure) 

• PM (Maintainability Test Procedure) 

• PR (Reliability Test Procedure) 

• PV (Integration/Compatibility Test Procedure) 

• UM (User’s Manual) 

• YV (General Engineering Data) 

b. Cpds.dot (Computer Program Development Specification) 
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c. Gr-a.dot (Smiths Aerospace ES–Grand Rapids drawing – PA, PB, 

PLT, etc.) 

d. HW-Test-Rpt.dot (HW Qual Test Report)  

e. Reference-manual.dot (Reference Manual – RM) 

f. Sdp.dot (Software Development Plan – ED) 

g. Slcd.dot (Software Life Cycle Document – SL) 

h. Sw-test-report.dot (Software Test Report – RPTxxxxxx-yyy) 

i. Sw-test-report-checklist.dot (Checklist for Software Test Reports) 

j. Sw-test-report-process.dot (Process description for creating SW Test 

Reports) 

k. Document-control-form.dot (CMO form required for document release 

– used by Document Writers) 

3.4 How to install templates. 

a. Click on the template link (open from its current location).  

b. Select File à Save As File …  
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c. Save to your Word 97 template directory 

(e.g., C:\Program Files\Office97\Templates).  

3.5 How to use templates. 

a. Open MS Word.  

b. Select File à New – a window opens containing your templates.  

c. Click ONCE on filename.dot (the template you want), then OK.  (If 

you double-click on the template itself, the template will open rather 

than a document based on it, and will forever retain the .dot extension 

rather than take on the .doc extension of a Word document.) 

d. Word opens a new document based on the template. 

3.6 Importing a template into existing document. 

a. For new documents, start with correct template. 

b. For legacy documents, can attach correct template, or import styles 

from correct template, to legacy Word document. 

(1) To attach template – Tools Menu  —>  Templates and Add-Ins  à  

Attach  à  Select template you want  à  Open  à  Automatically update 

document styles  à  OK 
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(2) To import styles – Format Menu  —>  Style  à  Organizer  à under right 

pane, click Close File, then Open File à Select template you want  à  

Copy styles from right pane to left pane à Close 

3.7 Changing template styles. 

Please DO NOT change the template styles to something you think is more 

appropriate or aesthetic, or create new styles to use in place of existing ones.  

They have been standardized, reviewed, and approved for Smiths Aerospace 

documentation requirements.  If changed, the Doc Writer will simply have to 

change them back to the approved styles, causing rework and increasing cost 

and schedule. 
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4. IN-HOUSE FORMAT BASICS (DPM) 

4.1 Required formatting. 

Formal documents, deliverable and non-deliverable, must contain the 

following, in accordance with the DPM: 

a. Cover Sheet with the following: Proprietary, export control, copyright, 

distribution notices, etc., as appropriate; correct Company Name and 

Address; Date and revision of database 

b. Revision History page (except for some Test Reports) 

c. Table of Contents, List of Figures (if applicable), List of Tables (if 

applicable) 

NOTE:  If the Engineer prefers, the Doc Writer will do any or all of the 

following:   

a. Create the Cover Sheet and Revision History page (DW will do) 

b. Create the TOC, LOF, and LOT 

c. Create the acronym list (DW will do) 

d. Populate Section 2.  APPLICABLE DOCUMENTS (DW will do) 
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These are required parts of the Doc Writer’s job, not the Engineer’s, but if 

the Engineer wishes to do any of these before submitting the doc to the 

Doc Writer, it will speed the document through the process. 

4.2 Required paragraphs. 

a. 1.  SCOPE – may include, but is not limited to, the following 

subparagraphs: 

• Introduction 

• Identification 

• Objective 

• Document summary 

• Purpose 

• Copyrights and Trademarks 

• Acronyms and abbreviations 

b. 2.  APPLICABLE DOCUMENTS 

Includes all documents, drawings, computer programs, and 

government and non-governments specs and standards referenced 

in the document after Section 2., including in appendices. Note:  

Document and drawing numbers referenced in SW code printouts, 

pseudocode, log files, test data, SW script files, computer screen 
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captures, etc., need not be included in Section 2. Anything ONLY 

referenced in scope does not need to go in applicable docs. 

(1) 2.1  Government documents. – Lists applicable Government 

documents, including MIL-SPECS, MIL-STDS, and MIL 

Handbooks. 

(2) 2.2  Non-Government documents. – Lists applicable non-

Government documents, including all referenced Smiths 

Aerospace documents and drawings. 

(3) 2.3  Computer programs. – Lists applicable computer programs. 

When referencing a document within the text, do not cite an exact 

issue. Cite the exact issue in the APPLICABLE DOCUMENTS 

section. 

 

Part numbers may be referenced in text where the purpose is to 

identify a specific item (e.g., 553000-01-01 or PLT6207-03-01); 

however, the document or drawing representing that part is what 

should be listed in applicable drawings (e.g., 553000 or PLT6207). 

 

Use the following application statements in a document. Apply the 

statement shown for 2.1  Government documents. and for 2.2  Non-

Government documents. 

Example:  2.1 Government documents.   

The following documents of the exact issue shown form a 
part of this document to the extent specified herein. For 
those documents showing no date of issue, the latest issue 
applies.  
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Use the following application statement for 2.3  Computer programs.: 

Example:  2.3 Computer programs.   

The following computer programs form a part of this 
document to the extent specified herein. 

 

Note:  If there are referenced documents under one numbered 

paragraph  (e.g., ‘‘2.1  Government documents.’’ or ‘‘2.2  Non-

Government documents.’’) but not the other, use this notation:  ‘‘This 

paragraph is not applicable to this document.’’ Note the following: 

Example:  2.2 Non-Government documents. This paragraph is not 
applicable to this document. 

If there are no referenced computer programs, omit ‘‘2.3  Computer 

programs.’’ 

c.  (3.  REQUIREMENTS) 

Barring other contractual requirements, the first two sections are 

always required, the third is recommended unless the required 

template says otherwise. 

4.3 Acronyms and abbreviations. 

Acronyms and abbreviations must either be included in a list (usually under 

Section 1.  SCOPE) or defined in parentheses on first use.  However, even 

when defined in a list, acronyms and abbreviations that fall before the list 

must be defined in text.  Acronyms that fall after the list may be defined in 

text but are not required to be. 

• Do not define company trade names such as IBM. 

• Do not define units of measure such as 10 Hz and 20 amps. 
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• Do not define an acronym used as part of a model number or a 

product line that is commercially available. A few examples follow: 

–  VAX (This is a product line.) 
–  IBM PC Jr.  (This is a model number.) 

• Do not define acronyms which are now more familiar than their 

definitions.  A few examples follow: 

–  RADAR 
–  ASCII 

4.4 Heading levels. 

Do not go below the template style Heading 7 for paragraph headings.  If 

titled subparagraphs are required under this level, use lettered, enumerated, 

or bulleted styles, or rewrite the text. 

4.5 Heading punctuation. 

Place periods at the end of all paragraph titles at Heading 2 level or below.  

The HEADING 1 level (e.g., 1.  SCOPE) is the only heading level that 

receives no ending punctuation. 

4.6 Use of TBD (To Be Determined). 

TBDs may be used only in DRAFT documents, not in PRELIMINARY or 

FINAL documents that are submitted to a Customer for approval. 

4.7 References to documents. 

References in text to other documents must reference, at a minimum, the 

document number.  Reference to the title may also be made, but is not 

sufficient by itself. 
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4.8 References to paragraph headings. 

Use the Insert Menu à Cross-reference option to create auto-references to 

paragraph headings. 

4.9 Figures and tables. 

Note:  the Doc Writer will format multi-page figures and tables 

4.9.1Referencing. 

All figures and tables must be referenced in text, by label (“Figure”, “Table”) 

and number only, not by title (e.g., see Figure 8).  No punctuation after 

the title. 

4.9.2Placement. 

Figures and tables must fall immediately after their first reference or on 

the next page. 

4.9.3Numbering. 

Number figures and tables consecutively with Arabic numerals in the order 

of their references. 

4.9.4Creating auto-references. 

Use the Insert Menu à Cross-reference option to create auto-references to 

figures and tables. 

4.9.5Creating captions. 

Use the Insert Menu à Caption option to create figure and table captions.  

If you don’t use Insert Menu à Caption, Insert Menu à Cross-reference 

won’t work to create auto-references. 
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4.9.6Caption placement. 

Figure captions go below figures, table captions above tables. 

4.9.7Caption capitalization. 

All important words in a figure caption must be initial-capped  

(e.g., Table 1.  Equipment List for the HUMS System Test) 

4.9.8Caption punctuation. 

• Type a period and two spaces after the label and number and 

before the title.  Do not use a hyphen or dash.   

• Do not place periods at the end of figure and table captions. 

4.10 Appendices. 

All appendices must be referenced in text.   

Identify and number appendices in accordance with the following: 

• Identify appendices (on their first sheets only) with the heading  

‘‘APPENDIX’’ and a Roman numeral. Begin Roman numerals with 

I and continue in ascending order.  

• Number each appendix section as 10., 20., 30., etc., in multiples of 

10 for each succeeding appendix. 

Note:  If a document has 10 or more sections preceding the 
appendices, number the appendices as sections 100., 200., 
300., etc., in multiples of 100 for each succeeding appendix. 

Follow the section number with the section title. Place the section number 
and title below the ‘‘APPENDIX’’ heading.  Note the following: 
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APPENDIX I 

10.  TEST DATA SHEETS 

 

• Use a section number that is 10 times the appendix number. (For 

example, use 10. for APPENDIX I, 20. for APPENDIX II, 30. for 

APPENDIX III, etc.) 

• Number paragraphs using the section number as a prefix: 

(10.1  Temperature shock data.). 

• Number the pages, figures, and tables of the appendices 

consecutively, beginning with 1 for each appendix, prefixed with the 

appendix number: 

(e.g., page I-1, Figure II-3, or Table IV-2). 

4.11 Company nomenclature. 

The company name and address are as follows: 

Smiths Aerospace, Inc., 
Electronic Systems – Grand Rapids 

3290 Patterson Avenue, SE 
Grand Rapids, MI  49512-1991, USA 

In text, it shall be as follows: 

 

Smiths Aerospace, Inc., Electronic Systems – Grand Rapids 

 

and shall be abbreviated as:  Smiths Aerospace. 

 

For current company name, address, and logo, go to: 
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Intranet Home Page à Engineering àà  Disciplines/Function àà  

“Standards on Line” àà  Drawing Format 

4.12 Section breaks. 

Create Word section breaks after title page, front matter, body, and to 

separate appendices, because headers and footers vary for these different 

parts of a document.   

 

Also create section breaks to switch from portrait mode to landscape and 

back. 

4.13 Small figures and tables (local data). 

You need not use a figure or table number and title to label data in columns 

and rows or in pictorial data pertaining only to an immediately preceding 

line or numbered paragraph and referenced generically (e.g., by the phrase 

‘‘as follows’’).   

 

However, do label data with a table or figure number and title if it is 

referenced more than a numbered paragraph away or later in the 

document. Local data may or may not be boxed and ruled. 

 

Consider using bulleted lists for some local tabular data. 
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5. WORD FORMATTING 

5.1 Some common problems and solutions. 

5.1.1Word replaces my styles, formats, or numbering with its own. 

Try the following: 

a. Tools Menu  —>  AutoCorrect  —>  AutoFormat As You Type  —>  

Uncheck Define styles based on your formatting (last option). 

b. Tools Menu  —>  Templates and Add-Ins  —>  uncheck 

Automatically update document styles. 

5.1.2The template I want doesn’t show up under File à New. 

You may not have your templates stored in the right folder, or Word may 

not be looking in the right folder. 

a. Place all Word templates that you use onto your local disk, in 

C:\Program Files\Microsoft Office\Templates.  See 3.1 for where to 

get them. 

b. In Word,  à  Tools Menu  —>  Options  —>  File Locations  —>  

select User templates  —>  Modify; set Local Disk(C:)\Program 

Files\Microsoft Office\Templates as your default template location. 
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5.1.3My table rows break across pages. 

•  Table Menu  —>  Select Table  —>  Cell Height and Width  —>  

Uncheck “Allow row to break across pages”. 

5.1.4My table runs off the page and I can’t see the last column. 

Change view to Normal view, and rearrange column widths. 

5.1.5I don’t want my links to automatically take me to the items they 

reference. 

a. Select link(s) you want to change (e.g., x-refs or TOC page numbers) 

b. Re-insert cross-reference over existing one (Insert Menu à Cross-

reference à Reference type à Heading), and uncheck the “Insert as 

hyperlink” box. 

5.1.6My third-level TOC numbers and below are bolded. 

Select TOC by clicking in left margin opposite first entry (usually  

1.  SCOPE), then press CTRL+B twice. 

5.1.7My page endings are different from someone else’s printout when I 

print the same file on my printer. 

a. Click Tools Menu à Options à Compatibility tab. 

b. In the Options window, uncheck the "Use printer metrics to lay out 

document" option (third from bottom). 
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c. Click Default button à Yes, to turn the printer metrics option off 

permanently. All new documents based on the template of your open 

document will have printer metrics turned off. 

If page endings are still different, create a PDF file and allow only it to be 

used for printing.  Since PDFs are image files, they will always print the 

same on any printer. 

5.1.8My document runs slow in Word. 

Try the following: 

• Change to Normal view; other views, especially Page Layout view, 

chew up memory and horsepower. 

• Turn off background repagination – Options Menu à General tab. 

Must be in Normal View or Outline View.  It is always on in Page 

Layout View. 

• Check Track Changes – options may be active even though not 

visible. 

• Work on your local drive; the traffic between your computer and 

the server slows down response time. 

5.2 Tips and shortcuts. 

5.2.1Work menu. 

Create a handy list of regularly used files for easy retrieval. 
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a. To create – Tools Menu  à  Customize  —>  Commands  à  

Categories (select Built-in Menus) à  Commands (select Work 

command) à  Drag onto toolbar 

b. To use – In oft-used file, Work Menu  à  Add to Work Menu; adds 

your file to the list.  Click on any file in list to open immediately. 

c. To delete – CTRL+ALT+hyphen à Work Menu à click on file. 

d. To get back to regular cursor, double-click in gray space of any 

toolbar, then close the Customize menu that comes up. 

5.2.2Change case. 

To quickly change the case of a word, phrase, or title, select it and press 

SHIFT+F3 to toggle between lowercase, Title Case, and UPPERCASE. 

5.2.3Repeat last action. 

Press F4 key to repeat whatever your previous action was.  Great for typing 

Roman numeral appendix prefixes in front of TOC page numbers. 

5.2.4Select columns of text. 

To select a vertical column of text, press ALT and drag your mouse down 

over the text, then copy or delete. 

5.2.5Drag command button onto toolbar for easy access. 

Tools menu à Customize à Commands tab à Select Commands 

category in left pane à Drag icon from right pane onto toolbar. 
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5.2.6Format painter (style painting). 

This is a very handy tool for applying the style properties of a piece of text 

to another piece of text.   

 

Add the Format Painter to the toolbar using the previous tip (it’s in the 

Format category).  When you want to make something in your document 

look like something else, select the item to be mimicked, click on the 

paintbrush icon on the toolbar, and drag it over (paint) the other item or 

click next to it in the left margin.   

 

If you want to do several paints, lock the Format Painter on by double-

clicking it.  Single-click it to turn it off again. 

 

Note:  Do not use the Previous Page or Next Page buttons to get to your 

paint “target,” or you will lose your paint. 

5.2.7Change table columns to exact widths. 

Place cursor in table.  In Table Menu à Select Table à Table Menu again 

à Cell Height and Width à Columns tab à change column widths in 

inches as you advance from column to column.  Also works for row heights. 

5.2.8Switch between two or more Word documents. 

If two or more Word documents open in the same window, instead of 

switching in the Window menu, press CTRL+F6 to toggle back and forth. 
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6. DOORS 

6.1 What is DOORS? 

Requirements management tool – Dynamic Object-Oriented Requirements 

System (DOORS); see DOORS SYSTEM DESCRIPTION handout. 

a. Each requirement statement or paragraph in a requirements doc 

becomes an object with a unique identifier that remains constant.  

These objects are linked between docs, up to higher level docs and 

down to lower level docs. 

b. Objects are contained within modules that are stored in a database. 

c. Keeps requirements uniform between docs.  

d. Provides comprehensive traceability, between requirements, design, 

and testing, between SRS, SDS, Test Procedure, Test Report. 

6.2 Which programs use DOORS? 

a. Programs currently using it – AB-139, NH-90, Sea King, Peace 

Marble VDAS, WAH-64 HUMS, UAE F-16 Block 60, KC-10A, and 

maybe A-129 Stinger. 

b. New programs that will be using it – 767 Tanker, C-130 AMP, JSF. 
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6.3 DOORS deliveries. 

DOORS deliveries could go one of two ways: 

(1) Delivery is standalone DOORS database module(s) 

(a) Must include the following: 

• Cover Sheet with the following: Proprietary, export 

control, copyright, distribution notices, etc., as 

appropriate; correct Company Name and Address; 

Date and revision of database 

• Section 1. SCOPE as required by CM 

• Section 2. APPLICABLE DOCUMENTS 

(b) Document format requirements won’t govern module.   

(c) Doc Writer will proof module for grammar, style, spelling, 

punctuation, and referenced documents, though not for format. 

(2) Word document shell (Title page, Rev History page, TOC, LOF, 

LOT, Sections 1. and 2.) references DOORS database(s) in 

Section 3.  Doc Writer will still proof database(s) for grammar, 

style, spelling, punctuation, and referenced documents 

The DPM will be updated to reflect these procedures. 

 

Most Doc Writers have taken the DOORS training. 
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APPENDIX I 

10. DPM-STYLE-DOC TEMPLATE 

The following pages contain the most common Smiths Aerospace, Inc., 

Electronic Systems – Grand Rapids template for in-house requirements, 

dpm-style-doc.dot. 
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